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performing data analysis to track endogenous mRNAs in their native cellular environment. 
 
 

 
Best wishes, 
 
 
Irina E. Catrina, PhD 
Diana P. Bratu, PhD 
 

Cover Letter



 1 
TITLE:  2 
Visualizing and Tracking Endogenous mRNAs in Live Drosophila melanogaster Egg Chambers 3 
 4 
AUTHORS & AFFILIATIONS:  5 
 6 
Irina E. Catrina1, Livia V. Bayer1,2, Omar S. Omar1,2 and Diana P. Bratu1,2 7 
1Biological Sciences Department Hunter College, City University of New York, New York, NY, USA 8 
2Program in Molecular, Cellular, and Developmental Biology, The Graduate Center, City 9 
University of New York, New York, NY, USA 10 
 11 
Corresponding Authors: 12 
Irina E. Catrina (icatrina@hunter.cuny.edu) 13 
Tel: (212) 772-5229 14 
 15 
Diana P. Bratu (bratu@genectr.hunter.cuny.edu) 16 
Tel: (212) 772-5235 17 
 18 
Co-authors: 19 
Livia V. Bayer (LJohnson@genectr.hunter.cuny.edu) 20 
Omar S. Omar (OOmar@genectr.hunter.cuny.edu) 21 
 22 
KEYWORDS:  23 
Molecular beacon, live cell imaging, endogenous mRNA visualization, mRNA trafficking, 24 
Drosophila melanogaster egg chamber, egg chamber microinjection, colocalization, particle 25 
tracking. 26 
 27 
SUMMARY: 28 
Here, we present a protocol for the visualization, detection, analysis and tracking of endogenous 29 
mRNA trafficking in live Drosophila melanogaster egg chamber using molecular beacons, spinning 30 
disc confocal microscopy, and open-source analysis software. 31 
 32 
ABSTRACT: 33 
Fluorescence-based imaging techniques, in combination with developments in light microscopy, 34 
have revolutionized how cell biologists conduct live cell imaging studies. Methods for detecting 35 
RNAs have expanded greatly since seminal studies linked site-specific mRNA localization to gene 36 
expression regulation. Dynamic mRNA processes can now be visualized via approaches that 37 
detect mRNAs, coupled with microscopy set-ups that are fast enough to capture the dynamic 38 
range of molecular behavior. The molecular beacon technology is a hybridization-based approach 39 
capable of direct detection of endogenous transcripts in living cells. Molecular beacons are 40 
hairpin-shaped, internally quenched, single-nucleotide discriminating nucleic acid probes, which 41 
fluoresce only upon hybridization to a unique target sequence. When coupled with advanced 42 
fluorescence microscopy and high-resolution imaging, they enable one to perform spatial and 43 
temporal tracking of intracellular movement of mRNAs. Although this technology is the only 44 
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method capable of detecting endogenous transcripts, cell biologists have not yet fully embraced 45 
this technology due to difficulties in designing such probes for live cell imaging. A new software 46 
application, PinMol, allows for enhanced and rapid design of probes best suited to efficiently 47 
hybridize to mRNA target regions within a living cell. In addition, high-resolution, real-time image 48 
acquisition and current, open source image analysis software allow for a refined data output, 49 
leading to a finer evaluation of the complexity underlying the dynamic processes involved in the 50 
mRNA’s life cycle.  51 
 52 
Here we present a comprehensive protocol for designing and delivering molecular beacons into 53 
Drosophila melanogaster egg chambers. Direct and highly specific detection and visualization of 54 
endogenous maternal mRNAs is performed via spinning disc confocal microscopy. Imaging data 55 
is processed and analyzed using object detection and tracking in Icy software to obtain details 56 
about the dynamic movement of mRNAs, which are transported and localized to specialized 57 
regions within the oocyte. 58 
 59 
INTRODUCTION:  60 
Cell biology studies that visualize dynamic events with spatial and temporal resolution have been 61 
made possible by the development of fluorescence-based live cell imaging techniques. Presently, 62 
in vivo mRNA visualization is achieved via technologies that are based on RNA aptamer-protein 63 
interactions, RNA aptamer-induced fluorescence of organic dyes and nucleic acid probe 64 
annealing1-3. They all offer high specificity, sensitivity and signal-to-background ratio. However, 65 
RNA aptamer-centered approaches require extensive genetic manipulation, where a transgene 66 
is engineered to express an RNA with artificial structural motifs that are required for protein or 67 
organic dye binding. For example, the MS2/MCP system requires the co-expression of a 68 
transgene expressing an RNA construct containing multiple tandem repeats of the binding 69 
sequence for the bacteriophage MS2 coat protein (MCP), and another transgene encoding a 70 
fluorescent protein fused to MCP4,5. The addition of such secondary structural motifs to the RNA, 71 
along with a bulky fluorescently tagged protein, has raised concerns that native RNA processes 72 
may be affected6. A technology that addresses this concern and offers additional unique 73 
advantages is the nucleic acid-based approach, molecular beacons (MBs). MBs allow for the 74 
multiplex detection of endogenous mRNAs, discrimination of single nucleotide variations, and 75 
fast kinetics of hybridization with target mRNA7,8. MBs are oligonucleotide probes that remain in 76 
a quenched hairpin fold prior to undergoing a fluorogenic conformational change once they 77 
hybridize to their targets (Figure 1C)9. Several groups have had success in using MBs to detect 78 
both non-coding RNAs (microRNAs and lncRNAs)10-13, RNA retroviruses14 and dynamic DNA-79 
protein interactions15. They have been successfully employed for imaging in various organisms 80 
and tissues, such as zebrafish embryos16, neurons13, tumor tissue17, differentiating 81 
cardiomyocytes18, and Salmonella19. 82 
 83 
Here we describe the design, delivery and detection approach for endogenous mRNAs in living 84 
D. melanogaster egg chambers coupled with a microscopy set-up that is fast enough to capture 85 
the dynamic range of active molecular transport. The D. melanogaster egg chamber has served 86 
as an ideal multicellular model system for a wide range of developmental studies, from early 87 
germline stem cell division and maternal gene expression to the generation of segmental body 88 



  

 
 
 

plan20,21. Egg chambers are easily isolated, large and translucent, and able to withstand hours of 89 
ex vivo analysis, making them highly amenable to imaging experiments. Much work has focused 90 
on the asymmetric localization of maternal transcripts to discrete subcellular regions prior to 91 
being actively translated. In particular, oskar mRNA localization and its subsequent translation at 92 
the oocyte’s posterior pole must occur in a tightly regulated manner to avoid a lethal bicaudal 93 
embryo phenotype22. oskar mRNA is transcribed in the 15 germline cells, called nurse cells, and 94 
actively transported through cytoplasmic bridges, called ring canals, into the oocyte, the germline 95 
cell that becomes the mature egg and is ultimately fertilized (Figure 1A). The considerable 96 
amount of information already available regarding the dynamic recruitment and exchange of 97 
protein factors to and from oskar mRNP, along with its long-range intracellular travel, make oskar 98 
a preferred candidate to study the many processes of the mRNA life cycle. MBs have been 99 
instrumental in revealing details about the process of mRNA localization and deciphering the 100 
regulation and function of protein factors that control mRNA transport during Drosophila 101 
oogenesis. In particular, by microinjecting MBs into nurse cells and performing live cell imaging 102 
experiments, the tracking of endogenous mRNAs is possible8,23. 103 
 104 
The roadmap presented here offers the steps of a complete process, from carrying out a live cell 105 
imaging experiment using MBs, acquiring imaging data, to performing data analysis to track 106 
endogenous mRNA in its native cellular environment. The steps can be modified and further 107 
optimized to meet the needs of researchers working with other tissues/cell types within their 108 
own lab setting. 109 
 110 
PROTOCOL:  111 
 112 
1. Design of MBs for Live Cell Imaging  113 

 114 
1.1. Fold the target RNA sequence to predict the mRNA target’s secondary structure using the 115 
“RNA form” from the mfold server (http://unafold.rna.albany.edu/?q=mfold/RNA-Folding-116 
Form). 117 
 118 
1.1.1. Paste/upload the target sequence in FASTA format, select 5 or 10% sub-optimality 119 
(structures with a free energy of folding within 5 or 10% of the MFE value, respectively), and 120 
adjust the maximum number of computed foldings accordingly (e.g. larger for 10% sub-121 
optimality). 122 
 123 
Note: Inclusion of sub-optimal secondary structures when designing MBs allows for the 124 
identification of regions within the target mRNA that may be more flexible or more rigid than as 125 
predicted for the minimum free energy (MFE) structure alone, which improves the overall design 126 
of MBs suited for live cell imaging. 127 
 128 
1.1.2. Select an “immediate job” for mRNA targets of 800 nucleotides (nt), or a “batch job” for 129 
mRNA lengths between 801 and 8,000 nt. Save the “ss-count” file as simple text file. 130 
 131 
1.2. Use the “ss-count” file obtained in step 1.1 as input for the PinMol program 132 
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(https://bratulab.wordpress.com/software/) with the desired parameters, to design several MBs 133 
for the mRNA target (see tutorials describing usage of PinMol program24 at 134 
https://bratulab.wordpress.com/tutorial-pinmol-mac/). 135 
 136 
1.2.1. Determine the specificity of selected MBs by performing BLAST analysis: use “blastn” with 137 
the appropriate database (e.g. for oskar mRNA-specific MBs use the “refseq-rna” database and 138 
the Drosophila melanogaster organism). 139 
 140 
1.2.2. Identify any tissue-specific expression of mRNA target (e.g. for oskar mRNA Flybase> High-141 
Throughput Expression Data> FlyAtlas Anatomy Microarray or modENCODE Anatomy RNA-Seq; 142 
http://flybase.org/reports/FBgn0003015) and compare with any positive BLAST hits. Eliminate 143 
probes that show > 50% cross-homology with other mRNAs that are also expressed in the 144 
tissue/cell of interest. 145 
 146 
1.3. Select the fluorophore and quencher pair appropriate for the microscopy set-up available to 147 
perform live cell imaging (e.g. Cy5/BHQ2)25. 148 

 149 
2. MB synthesis, purification and characterization 150 
 151 
2.1. Use in-house synthesis and purification as previously described7, or services from 152 
commercial providers, to synthesize and purify one to five MBs (see above note), using the 153 
following labeling scheme: [5’(Fluorophore)-(C3 or C6 linker)-(2’-O-methyl MB sequence)-154 
(Quencher)3’]. Purify MBs using reverse-phase HPLC, in house or using the services of the 155 
commercial provider. 156 
 157 
Note: The phosphoramidites used for automated probe synthesis must have the 2’-O-methyl 158 
ribonucleotide modification. One can also use chimeras of alternating locked-nucleic acid (LNA) 159 
and 2’-O-methyl modifications to increase the stability of a hybrid between a shorter MB and its 160 
target mRNA26. 161 
 162 
2.2. Synthesize DNA oligonucleotides that match the sequence of the targeted RNA region and 163 
thus are complementary to the probe region of MBs, for use in in vitro characterization (see steps 164 
2.3 to 2.5; above note). Maximize hybridization of the MB with the DNA-oligonucleotide target 165 
mimic, by including on each end of the DNA target four additional nucleotides, as found in the 166 
target mRNA sequence. 167 

 168 
Note: A more rigorous characterization of the MB’s efficiency to detect the targeted sequence 169 
can be performed using in vitro synthesized RNA targets instead of complementary DNA 170 
oligonucleotides8. 171 
 172 
2.3. Perform thermal denaturation of the MB alone, measure its melting temperature (Tm), and 173 
confirm that the MB assumes the desired hairpin shape at physiological temperature. We have 174 
observed Tm values between 60 and 90 °C. 175 
 176 

https://bratulab.wordpress.com/software/
https://bratulab.wordpress.com/tutorial-pinmol-mac/
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2.4. Perform thermal denaturation of the MB in the presence of the DNA oligonucleotide target 177 
and measure the MB:DNA target hybrid’s Tm, as previously described7. A Tm between 55 and 60 178 
°C is desired for the MB:DNA hybrid. 179 
 180 
2.5. Perform in vitro hybridization reactions with the corresponding DNA oligonucleotide target, 181 
and determine the efficiency of MB:DNA hybrid formation at physiological temperature, as 182 
previously described7. Fast hybridization kinetics with the DNA target mimic is desired, however 183 
MBs that do not show high hybridization efficiency with DNA targets may have a better 184 
performance with the target mRNA in vitro and/or in vivo. 185 
 186 
3. Dissection and Preparation of Individual Egg Chambers for Microinjection 187 
 188 
3.1. Feed newly hatched, mated females for 2-3 days with fresh yeast paste. 189 
 190 
3.2. Anesthetize flies on a CO2 pad and, using fine tweezers (Dumont #5), transfer 1-2 females 191 
into a drop of Halocarbon oil 700 on a glass cover slip. 192 
 193 
3.3. Using a pair of tweezers, orient the fly with the dorsal side up under a stereomicroscope. 194 
Dissect the female abdomen by making a small incision at the posterior end and gently squeeze 195 
the pair of ovaries into the oil. 196 
 197 
3.4. Explant the ovaries onto an oil drop on a new coverslip. Gently hold one ovary with one 198 
tweezer while pinching off the youngest stages of the ovariole with the other tweezer. oskar 199 
mRNA is actively localized at and after mid-oogenesis (stages > 7), and younger egg chambers ( 200 
stages < 7) are more difficult to inject and do not survive as long. Slowly drag on the cover slip 201 
(with a downward movement) until individual ovarioles or egg chambers are isolated and aligned 202 
vertically. Further separate single egg chambers by displacing the unwanted stages from the 203 
ovariole egg chain. 204 

 205 
Note: Ensure that individually teased egg chambers do not float in the oil, and that they adhere 206 
to the cover slip. This is important for both successful microinjection and image acquisition. 207 
 208 
4. Microinjection of MBs into the Nurse Cells of Egg Chambers  209 

 210 
4.1. Prepare the MB solution, using one molecular beacon (e.g. osk2216Cy5), or a mix of two MBs 211 
that target different mRNAs and which are labeled with spectrally distinct fluorophores (e.g. 212 
osk2216Cy5 and drongo1111Cy3). Use a concentration of 200-300 ng/µL each MB in HybBuffer 213 
(50 mM Tris-HCl - pH 7.5, 1.5 mM MgCl2 and 100 mM NaCl). For a cocktail of four MBs labeled 214 
with the same fluorophore that are targeting the same mRNA at 200 ng/µL each in HybBuffer 215 
(e.g. osk82, osk1236, osk2216). Spin down the MB solution immediately prior to loading the 216 
needle for microinjection. 217 
 218 
4.2. Select the objective. A 40X oil objective is recommended for finding an appropriate egg 219 
chamber and for performing microinjection. 220 



  

 
 
 

 221 
4.3. Mount the coverslip with dissected egg chamber onto the microscope stage. Bring up the 222 
objective in the focus position and identify an egg chamber at a mid-to-late developmental stage, 223 
that is properly oriented for microinjection (i.e., with the AP axis perpendicular to the needle 224 
tip to allow for easy injection within a nurse cell proximal to the oocyte). 225 
 226 
4.4. Load a needle (commercial or prepared in house27) with ~1 µL MB solution (see step 4.1) and 227 
connect it to the microinjector. For microinjections in D. melanogaster egg chambers, orient the 228 
needle (see Table of Materials) at an angle < 45° to the microscope stage (e.g. 30°) to avoid 229 
puncturing several nurse cells. 230 
 231 
4.5. Set-up the injector with injection pressure of 500-1,000 hPa and compensation pressure of 232 
100-250 hPa (see Table of Materials). 233 
 234 
4.6. Slowly move the stage to bring in the field of view an area of the oil drop void of egg 235 
chambers. 236 
 237 
4.7. Using the micromanipulator joystick, gently lower the needle into the oil drop and bring its 238 
tip into focus towards the periphery of the field of view. 239 
 240 
4.8. Perform a ‘clean’ function to remove the air from the tip of needle and to ensure that there 241 
is flow from the needle. 242 
 243 
4.9. Bring the needle to the home position and focus on the egg chamber to be microinjected, 244 
then bring the needle back into focus and position it near the edge of the egg chamber. 245 
 246 
4.10. Perform a fine adjustment of the objective’s Z-position such that the membrane separating 247 
the follicle cells from nurse cells is in focus. 248 
 249 
4.11. Insert the needle into a nurse cell and perform injection for 2-5 s. 250 
 251 
4.12. Gently remove the needle and retract it to the home position. 252 
 253 
4.13. Change the objective to the desired magnification for image acquisition (60-63X or 100X), 254 
focus on the egg chamber, and begin acquisition. 255 
 256 
5. Acquisition of Data Using a Spinning Disc Confocal Microscope Setup  257 
 258 
Note: See Table of Materials for our specific setup. 259 

 260 
5.1. Set up acquisition protocol to record an XYZCt stack of 8-16-bit images (XYZ = volume, C = 261 
channel, t = time). 262 
 263 
5.2. Select laser lines for the desired channels (e.g. 641 nm laser for Cy5 and 491 nm for GFP) and 264 



  

 
 
 

acquire the channels sequentially: first the fluorescence signal in each channel and then change 265 
the Z position, to allow for proper colocalization analysis. 266 
 267 
5.3. Select the Z step (e.g. 0.3 µm), and the top and bottom Z limits (e.g. -2 µm to 2 µm). 268 
 269 
5.4. Input the acquisition time and sampling rate (e.g. every 15-30 s for up to 1 h). 270 
 271 
5.5. Initiate acquisition. 272 
 273 
6. Processing, Data Analysis to Obtain Tracking and Colocalization Information, and 274 
Preparation of Video Files  275 
 276 
6.1. Image Processing 277 
 278 
6.1.1. Download, unpack, and open Icy, an open community platform for bioimage informatics 279 
(http://icy.bioimageanalysis.org/) 280 
 281 
6.1.2. Open the XYZCt stack acquired in step 5: Image/Sequence >File>Open. 282 
 283 
6.1.3. Convert stack to ImageJ: ImageJ> Tools> Convert to IJ, have Detached Mode ON. 284 
 285 
6.1.4. Make a substack (a selection of a range of Z steps and time points to be further analyzed): 286 
ImageJ>Image>Stacks>Tools>Make Substack…; select the desired channels, Z-steps and time 287 
points. 288 
 289 
6.1.5. Save substack as TIFF file: ImageJ>File>Save As>Tiff…; use this file for subsequent steps. 290 
 291 
6.1.6. Split channels: ImageJ>Image>Color>Split Channels. 292 
 293 
6.1.7. Subtract background either using a background stack: ImageJ>Process>Image Calculator…, 294 
or using the Rolling ball option: ImageJ>Process>Subtract Background…, select the Rolling ball 295 
radius. Preview the image for the radius selected before selecting “Accept”.  296 

 297 
Note: Background signal will mainly arise from improper quenching of the flurorophore. The 298 
signal:background ratio (S:B) is often used as an indicator for an MB’s “brightness”, and it is 299 
measured from in vitro hybridization experiments of the MB and DNA target oligonucleotide. For 300 
example, MBs osk1236 and osk2216 have an S:B of ~81 and ~120, respectively.  301 
 302 
6.1.8. Adjust the brightness and contrast for each channel: 303 
ImageJ>Image>Adjust>Brightness/Contrast, select Apply. 304 
 305 
6.1.9. Save each channel as a separate TIFF file: ImageJ>File>Save As>Tiff.... 306 
 307 
6.1.10. Merge the two channels: ImageJ>Image>Color>Merge Channels…; select the channels. 308 

http://icy.bioimageanalysis.org/


  

 
 
 

Save the new stack as a new TIFF file (see step 6.1.8). 309 
 310 
6.2. Spot Detection and Tracking 311 
 312 
6.2.1. Convert back to Icy: ImageJ>Tools>Convert to Icy. 313 
 314 
6.2.2. A scale bar is automatically overlaid onto the stack upon conversion to Icy, if the scale bar 315 
plugin is installed [Search using Plugins>Setup>Online plugin]. If needed, edit the scale bar via 316 
Inspector window (right side of screen)>Layer tab>Name>Scale bar. 317 
 318 
6.2.3. Deselect/inactivate the ‘eye’ icon for Scale bar from the Layer tab>Name to remove the 319 
scale bar from the original stack. It can be reactivated on the final stack. 320 
 321 
6.2.4. Save the newly processed stack by taking a screenshot using the “camera” icon from the 322 
Image Window’s menu bar, “Take a screenshot of current view” and File>Save as>Tiff….  323 
 324 
6.2.5. Determine spot sensitivity, if spot sensitivity parameters have already been determined 325 
move onto step 6.2.7.  326 
 327 
6.2.6. Detect spots: select the window with the image or stack to be analyzed, 328 
Detection&Tracking>Detection>Spot Detector, and fill in the Settings parameters: 329 
 330 
6.2.6.1. For Input, select “currentSequenceInputDetection” (default). 331 
 332 
6.2.6.2. For Pre Processing, select “Channel 0” (default), or desired channel by cross-referencing 333 
the number in the Inspector window>Sequence tab. 334 
 335 
6.2.6.3. For Detector, select “Detect bright spot over dark background;” use “Force use of 2D 336 
Wavelets for 3D” only if there are not enough Z-slices in the stacks to perform the analysis. Select 337 
“Scale(s)” and “Sensitivity” for each scale (add more scales for larger spots). The Scale and 338 
Sensitivity (the larger the number the more sensitive is the detection, a maximum of 140 is 339 
suggested by Icy) are trial and error variables, that must be visually checked afterwards and 340 
decided upon. 341 
 342 
6.2.6.4. For Region of Interest, use “ROIfromSequence” (default). 343 
 344 
6.2.6.5. For Filtering, use “NoFiltering” (default), or select “SizeFiltering” to define the “Range of 345 
accepted objects (in pixels)”. 346 
 347 
6.2.6.6. Output: select XLS or XML output setting (select XML format when using 2007 MS Excel 348 
or earlier and there are > 65,000 spots). If the spot detector results are used for the tracking 349 
analysis, also select “Export to SwimmingPool”. 350 
 351 
6.2.6.7. Repeat detection of spots using various scale/sensitivity values until all or most of the 352 



  

 
 
 

spots are detected. Record all of the final parameters. 353 
 354 
6.2.6.8. For colocalization analysis, repeat spot detection for the other channel. 355 
 356 
6.2.7. To track spots, select Detection&Tracking>Tracking>Spot Tracking>Run the Spot Detector 357 
with parameters from step 6.2.6., or use “Select detection results here” pull-down menu to select 358 
an existing dataset (for this, keep Spot Detector window open from step 6.2.5). Press the 359 
“Estimate parameters” button and select the desired target motion in the Parameters estimation 360 
pop-up window (e.g. “is both diffusive and directed”). Press the “Run tracking” button. 361 
 362 
6.2.8. Repeat spot detection and tracking for other channels when tracking spots of multichannel 363 
stacks, following steps 6.2.6 and 6.2.7, beginning with the stack generated from step 6.2.7. 364 
 365 
6.2.9. To visualize tracks, select Detection&Tracking>Tracking>Track Manager – this window 366 
opens automatically upon completion of a tracking run. For “Color Track Processor,” select 367 
“Enable” and choose the desired representation of color for the tracks. Relevant track processors 368 
can be accessed via the “add Track Processor…” pull-down menu (e.g. select “Track Processor 369 
Time Clip,” enable the “Track Clipper” window, and choose the desired number of detections to 370 
be displayed before and after the current time point.) 371 
 372 
6.2.10. Save tracks information as an XML track file: Detection&Tracking>Tracking>Track 373 
Manager>File>Save as…. 374 
 375 
6.2.11. Save results by taking a screenshot using the “camera” icon from the Image Window’s 376 
menu bar, “Take a screenshot of current view”. Screenshots can be taken with the detected spots 377 
and/or the tracks simply by activating/deactivating the corresponding eye icon(s) found in 378 
Inspector window>Layer tab>Name>Overlay wrapper. 379 
 380 
6.2.12. Install the TimeStamp Overlay plugin: Plugins>Setup>Online plugin>TimeStamp 381 
Overlay>Install. 382 
 383 
6.2.13. Add timestamp: Plugins>TimeStamp Overlay (New). Follow instructions on the pop-up 384 
window (lower right corner of screen) for directions on placing and formatting the time stamp. 385 
The time interval can be added/changed in the Inspector window>Sequence tab>Sequence 386 
Properties>Edit. 387 
 388 
6.2.14. Save results by taking another screenshot. Save image as 1) Tiff format, and 2) as AVI 389 
format; for AVI format first convert to RGB rendering (Image/Sequence>Rendering>RGB image). 390 
 391 
6.2.15. Rotate image to desired orientation: Inspector window>Sequence tab>Canvas>Rotation. 392 
 393 
6.2.16. Save rotated image by “Take a screenshot of the current view”. Ensure the “eye” icon for 394 
the scale bar is deselected, as it will also rotate with the image. 395 
 396 



  

 
 
 

6.2.17. Choose and crop ROI: select Region Of Interest>2D ROI>Choose ROI shape and then 397 
create/draw ROI on the image; Image/Sequence>Plane (XY)>Fast crop. 398 
 399 
6.3. Colocalization analysis 400 
 401 
6.3.1. Prepare a colocalization protocol; several examples are provided on the Icy website 402 
(http://icy.bioimageanalysis.org/protocol/List) (see Supplemental Materials). 403 
 404 
6.3.2. Load colocalization protocol: Tools>Scripting>Protocols>Load, and adjust parameters in 405 
the interacting blocks (e.g. in the “Wavelet Spot Detecting” block use parameters determined in 406 
step 6.2.6.). 407 
 408 
6.3.3. Measure the size of a particle in pixels, determine the colocalization distance and input it 409 
into “Colocalizer” block as “Max distance.” 410 
 411 
Note: The size of the particle in pixels depends on the detection system. To measure size, zoom 412 
into a single particle and manually count the pixels that span the width of the signal across. 413 
Average the measurements from at least three particles. The maximum distance to be set for 414 
colocalization is the size of the particle in pixels (this represents the maximum sum of the radius 415 
of two particles touching). 416 
 417 
6.3.4. If desired, select one or more ROIs for colocalization analysis: Region Of Interest>2D 418 
ROI>Choose ROI shape>Draw ROI on image.  419 
 420 
6.3.5. Crop ROI(s): Image/Sequence>Plane (XY)>Fast crop. 421 
 422 
6.3.6. Perform colocalization: Protocols editor window>Chosen protocol tab>Run. The final block 423 
in Protocols editor window will contain overall colocalization percentage based on spot 424 
detection, while information at each time point can be found in the Inspector window> Output 425 
tab. 426 
 427 
6.3.7. Track colocalized and single particles by following step 6.2.7 (Track spots). 428 
 429 
6.3.8. Save as described in step 6.2.16. 430 
 431 
REPRESENTATIVE RESULTS:  432 
 433 
Using PinMol, several MBs can be designed for one mRNA target (Figure 1B-C). After synthesis 434 
and purification, the selected MBs are characterized and compared using in vitro analysis. 435 
 436 
[Insert Figure 1 here] 437 
 438 
After optimum performance of MBs is confirmed via in vitro characterization, the probes are used 439 
for live visualization of endogenous target mRNA(s). It is possible to visualize the patterns of oskar 440 

http://icy.bioimageanalysis.org/protocol/list


  

 
 
 

mRNA transport and localization at various stages of oogenesis, and in particular at and after 441 
mid-oogenesis (7-10) (Figure 2A-B). Due to their small size, it is difficult to inject egg chambers at 442 
very early stages (1-4). When individually injected in the same stage egg chambers, oskar-specific 443 
MBs present the same patterns of localization (Figure 2, osk1236 vs osk2216). 444 
 445 
[Insert Figure 2 here] 446 
 447 
Different mRNA targets can be co-visualized by using spectrally distinct fluorescently labeled MBs 448 
(Figure 3). The MB solution can be microinjected into a nurse cell (Figure 3A) or into the oocyte 449 
(Figure 3B). MBs injected into a nurse cell’s cytoplasm will freely diffuse into the other nurse cells 450 
as well as into the oocyte, and thus are able to find their target and generate fluorescence signal 451 
at other sites than the microinjection site. For example, when performing microinjections in a 452 
nurse cell of a late oogenesis stage (9-10) egg chamber, most of the fluorescence signal visualized 453 
within the oocyte is generated by the already localized oskar mRNA, and less by actively 454 
transported transcripts, which are more prevalent in earlier stages (7-8). Note that classical MBs 455 
will give rise to non-specific signal within the nuclei, therefore limiting the analysis to the 456 
cytoplasmic regions of the egg chamber. Additional modifications, such as NeutrAvidin or gold 457 
nanoparticles, have been employed to reduce or eliminate this non-specific signal28,29. In spite of 458 
this nuclear non-specific signal, the specificity of MBs for in vivo detection of oskar mRNA has 459 
been established using a FRET approach8, and MB co-injection with in vitro transcribed oskar 460 
mRNA labeled with a fluorophore spectrally distinct from the MB’s label23. 461 
 462 
[Insert Figure 3 here] 463 
 464 
For mRNA targets that show low expression levels, the fluorescence signal per mRNA molecule 465 
is increased by injecting a cocktail solution containing at least two MBs, each binding to different 466 
target regions (Figures 4 and 5). 467 
 468 
[Insert Figure 4 here]  469 
 470 
[Insert Figure 5 here] 471 
 472 
When comparing trafficking of oskar mRNA as detected with MBs vs MS2/MCP, the fluorescence 473 
signal generated by oskar-specific MBs faithfully documents on the transport and localization of 474 
transgenic oskar mRNA labeled with 10 GFP molecules via the MS2/MCP system (Figure 4). In 475 
oskar-MS2/MCP-GFP transgenic egg chambers at mid oogenesis, acquisition data analysis 476 
showed extensive colocalization between fluorescent signals of genetically engineered oskar-477 
MS2 mRNA detected using MBs and GFP-tagging. At 12 and 14 min post-injection, 57% (7 MB-478 
objects and 13 GFP-objects, with 4 colocalized objects) and 93% (30 MB-objects and 51 GFP-479 
objects, with 28 colocalized objects) of detected MB particles colocalized with GFP particles in 480 
the nurse cells and oocyte, respectively. Our analysis yields 31% and 55% colocalization 481 
percentages of oskar-MS2 mRNA with oskar mRNA detected with MBs within the cytoplasm of a 482 
nurse cell and the oocyte, respectively. Moreover, 5D-stacks can be further analyzed to 483 
determine oskar mRNA trajectories for long-distance transport in both the nurse cell and oocyte 484 



  

 
 
 

cytoplasm (Figure 5). 485 
 486 
FIGURE AND TABLE LEGENDS: 487 
 488 
Figure 1. Technique and tissue description for live cell imaging of endogenous mRNAs. (A) 489 
Depiction of a mid-stage Drosophila egg chamber used for microinjection. The microinjection 490 
needle (green) delivers a cocktail of molecular beacons specific for oskar mRNA. A quick injection 491 
into a nurse cell enables detection of mRNAs in transit to the oocyte, as well as visualization of 492 
already localized mRNA at the posterior cortex. (B) PinMol software output of molecular beacon 493 
ranking for targeting oskar mRNA (C) Secondary structure region within oskar mRNA targeted by 494 
a molecular beacon. (C’) Sequence and folding of oskar-specific molecular beacon, osk2216. 495 
 496 
Figure 2. Time sequence of oskar mRNA in wild type egg chamber at t = 0, 10, and 30 min time 497 
points, after initiation of acquisition. Nurse cell injections of two oskar-specific molecular 498 
beacons (osk1236 and osk2216) in (A) stage 6-7 egg chambers and (B) stage 9 egg chambers. 499 
Scale bar, 20 µm. 500 
 501 
Figure 3. Co-visualization of two mRNA species in live egg chambers. Co-injections of oskar- and 502 
drongo-specific molecular beacons in the (A) nurse cell and (B) oocyte of stage 8-9 egg chambers. 503 
oskar (red) and drongo (green) mRNAs colocalize at the posterior end of the oocyte (asterix), and 504 
drongo also shows dorso-anterior accumulation (arrowhead). Scale bar, 20 µm. 505 
 506 
Figure 4. Visualization of oskar mRNA with both MBs and MS2-GFP system. Microinjections of 507 
a MB cocktail solution (MB) in an egg chamber expressing osk-MS2::MCP-GFP30 (GFP). After the 508 
microinjection of a nurse cell, images were acquired every 30 s for 20 min. Two regions of interest 509 
were selected, one ROI in a nurse cell and one in the oocyte. Different sensitivity was used for 510 
each ROI to detect the spots. ROI nurse cell: Scale 2, Sensitivity 100 for GFP and MB. ROI oocyte: 511 
Scale 2, Sensitivity 50 for GFP and 110 for MB. Colocalization distance is 4 pixels for both ROIs. 512 
The whole egg chamber and the zoom in on the nurse cell are shown at the 12-min time point, 513 
and the zoom in on the oocyte is shown at the 14-min time point. MB spots (red circles) and GFP 514 
spots (green circles) identify oskar mRNA particles detected by each approach, and the 515 
colocalized particles (yellow) indicate where MB and GFP spots are at most 4 pixels apart. XY-516 
projections of 14 Z optical slices at 0.3 µm steps. Acquired as 16-bit data with an 63X objective 517 
(oil, NA = 1.4), XY = 0.24 µm, exposure time 500 ms, at 5.23 and 5.39 mW laser power for the 641 518 
nm and 491 nm laser, respectively. Scale bar, 10 µm. 519 
 520 
Figure 5. Tracking analysis in the oocyte, after nurse cell microinjection with oskar mRNA-521 
specific MBs. MB particles were detected at Scale 2 with Sensitivity 110, and 8 time points are 522 
shown before/after the current time frame. MB spots (red circles) are tracked in the volume of 523 
the oocyte; tracks represent detection information from 8 time points before/after the shown 524 
12-min time point. Each color represents an individual track. XY-projections of 14 Z optical slices 525 
at 0.3 µm steps. Scale bar, 10 µm. 526 
 527 
DISCUSSION: 528 



  

 
 
 

Live visualization of endogenous mRNA trafficking in Drosophila egg chambers relies on the use 529 
of specific, efficient, and nuclease-resistant MBs, which can now be easily designed with PinMol 530 
software. MBs are specific probes designed to detect unique sequences within a target mRNA 531 
(preferably regions free of secondary structure), making possible highly resolved detection of a 532 
transcript. The only limitation when adopting this technique/protocol for other tissues/cell types 533 
is the efficiency of MB delivery for the specimen of interest. While other approaches require 534 
genetic manipulation of the tissue to express an aptamer and an RNA-binding protein tagged 535 
with a fluorescent protein to visualize one target mRNA (e.g. MS2/MCP system), multiplexing is 536 
possible for, at most, two transcripts. MB technology stands alone for detecting endogenous 537 
mRNAs in living cells, and it is the only technique permitting the co-visualization of more than 538 
two mRNA species. 539 
 540 
MBs can be labeled with a wide range of fluorescent moieties and are stable within the cellular 541 
environment when synthesized from modified nucleotides such as 2’-O-methylribonucleotides 542 
or locked-nucleic acids26,31. These backbone modifications also increase MBs’ affinity for their 543 
target. Several MBs can be easily designed for target mRNAs of average length. However, some 544 
limitations may be encountered for short and/or highly structured targets. This can be overcome 545 
by adopting our tiny molecular beacons, for which the probe region is approximately half of the 546 
length of a classical MB probe31. Depending on the specimen type, MBs are delivered into cells 547 
via electroporation, linking to cell-penetrating peptides, lipofection, or microinjection23,32-34. An 548 
MB’s performance efficiency in live cell imaging experiments leans on the capability of the probe 549 
sequence to hybridize to the corresponding complementary sequence within the mRNA target, 550 
which is determined by the target structure. The predicted MFE RNA secondary structure 551 
obtained using in vitro measured thermodynamics parameters is valuable in assessing target 552 
accessibility, but ultimately it is the in vivo target structure and the target interaction with other 553 
cellular factors that will determine the MB’s suitability for live cell imaging. Genome-wide 554 
analysis of RNA secondary structure suggests that many RNAs are less structured in vivo than in 555 
vitro35. Although the efficiency of in vivo target detection using MBs is mainly dependent on the 556 
accessibility of the binding site, optimizing certain MB features will ensure an enhanced 557 
visualization of the mRNA target. Specifically, a careful selection of the following parameters 558 
should be performed: 1) the probe length can vary between 18 and 26, such that the probe’s 559 
nucleotide composition is between 31 and 55% GC pairs in the target:MB hybrid, 2) the 5 bp stem 560 
sequence should be G/C rich, to maintain the hairpin shape in absence of mRNA target and to 561 
provide mismatch discrimination, 3) a modified backbone should be used for protection against 562 
nucleases of both MB and target:MB hybrid, 4) the fluorophore/quencher pair can offer an 563 
additional modest stability to the MB’s stem, and 5) the fluorophore should be stable during long 564 
imaging time intervals. In addition, classical MBs usually generate a nuclear non-specific signal34, 565 
which in our case only moderately impacts data processing and analysis. However, for mRNA 566 
trafficking visualization at cellular level, this non-specific signal may become problematic. Several 567 
groups have proposed modifications or tags, such as tRNA, peptides and nanoparticles, which 568 
prevent the delivery of MBs into the nucleus and thus eliminate this possible non-specific 569 
signal33,36. 570 
 571 
The biggest drawback of this approach has been the manual design of MBs for live cell imaging. 572 



  

 
 
 

To address this, we have written a Python-based program (PinMol) that readily identifies 573 
accessible target sites within an mRNA by considering suboptimal secondary structures in 574 
addition to the MFE, as well as designs hairpin probes, which are best suited for detection of 575 
mRNAs in live cells24. PinMol uses structural information from secondary structures of the target 576 
RNA predicted via energy minimization approaches, and by including information from 577 
suboptimal structures, the flexibility or rigidity of specific targeted regions is assessed when 578 
designing MBs. It takes into account the accessibility of the targeted regions, as well as the inter- 579 
and intramolecular interactions of each selected probe. Additionally, highly regulated stretches 580 
of RNA (e.g. binding sites for microRNAs or RNA-binding proteins) should not be considered as 581 
target sites when selecting probes, as these regions may result in inefficient binding of the MBs. 582 
The user can evaluate and eliminate probes targeting these sites, or restrict the target region 583 
used by PinMol to design probes so it does not include such sites. The relative capability of PinMol 584 
was demonstrated by comparing the ranking of PinMol designed MBs with the experimental 585 
results of manually designed MBs24. Pinmol selected and designed MBs for similar target regions 586 
as well as identified new accessible sites on the mRNA. This is essential for the detection of low 587 
copy number transcripts where the fluorescent signal must be increased above background. By 588 
scaling up the MB numbers which effectively hybridize to several accessible sites on a target 589 
mRNA, signal amplification can be achieved. Therefore, this program facilitates a fast approach 590 
to design multiple MBs per target mRNA, and to simultaneously visualize numerous mRNAs in a 591 
live cell.  592 
 593 
In order to achieve high quality 5D (XYZCt) acquisition data of transported mRNAs within the egg 594 
chamber, proper dissection of individual egg chambers and effective microinjection into nurse 595 
cells are critical. For studies during early stages of development, microinjection can be 596 
detrimental to the viability of the egg chamber and thus the length of a live cell imaging 597 
experiment is shortened (< 20 min). An increased success rate of the microinjection experiments 598 
can be ensured by using commercially available ultrafine needles. In addition, a quick set-up of 599 
the acquisition settings is important so that the early, post-injection time points can be captured. 600 
The quality of the spot detection and tracking data will only be as good as the quality of the 601 
images acquired. 602 
 603 
Upon image acquisition, it is essential that subsequent analysis steps are also completed carefully 604 
and precisely. Although post-acquisition processing and analysis offer their own set of difficulties, 605 
they can be streamlined by choosing the appropriate software for one’s particular experiment or 606 
sample. Current existing programs include Volocity (PerkinElmer), Imaris (Bitplane), ImageJ/Fiji 607 
and Icy37. Of the three, Icy offers several benefits, as it is an open community platform that allows 608 
for, both, processing (via ImageJ) and analysis of imaging data. Here we describe the steps 609 
necessary for efficient processing and analysis of RNA imaging data using Icy. Our results are 610 
representative of data obtained by co-visualizing two mRNA species in a whole egg chamber and 611 
by tracking an mRNA via the MB technology and the MS2/MCP system. 612 
 613 
The post-acquisition processing with Icy software provides user flexibility in the image processing 614 
(e.g. brightness, contrast) and analysis (e.g. the thresholds/cut-offs settings for sensitivity of 615 
detection of the fluorescent particles as spots). Icy also enables the control relevant parameters 616 



  

 
 
 

within each block of the Protocols Editor run (e.g. determine the colocalization distance and use 617 
it as “Max distance” into the “Colocalizer” block). Icy software is updated at launch, and has 618 
reliable online support to troubleshoot any problems. The described protocol was designed for 619 
detecting oskar mRNA and the representative results were obtained using parameters optimized 620 
for the kind of mRNA particle to be detected and tracked. For example, oskar mRNA is an 621 
abundant transcript that is predominantly transported during mid stages of oogenesis, utilizing 622 
the microtubule network and dynamically associating with various protein factors throughout 623 
development of the oocyte. We previously reported that oskar mRNP undergoes extensive 624 
remodeling during transport from the nurse cells into the oocyte23. In addition, using MBs we 625 
characterized the temporal and spatial characteristics of endogenous oskar mRNA trafficking, 626 
and found that hundreds of oskar transcript copies can be incorporated to form large oskar 627 
mRNPs.  628 
 629 
Post-acquisition analysis for colocalization and tracking can also be performed by using other 630 
software such as Imaris, ImageJ/Fiji and Volocity. Icy was selected for its capability to threshold 631 
and annotate fluorescent particles with high sensitivity and tracking capabilities. Here, we 632 
describe object-based colocalization, but colocalization, albeit without tracking, can also be 633 
quantified by determining the overlap and degree of colocalization using PCC(Costes) analysis 634 
using Icy and ImageJ plugins (Colocalization studio, JACoP)38,39. 635 
 636 
In the future, an optimized, long-term imaging protocol is desired to ensure extended egg 637 
chamber survival. This would provide longer acquisition in order to analyze data pertaining to 638 
long-range mRNA trafficking studies. 639 
 640 
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Name of Material/ Equipment Company Catalog Number

Spectrofluorometer Fluoromax-4 Horiba-Jobin Yvon n/a

Quartz cuvette Fireflysci (former Precision Cells Inc.) 701MFL

Dumont #5 tweezer World Precision Instruments 501985

Halocarbon oil 700 Sigma-Aldrich H8898

Cover slip No.1 22 x 40mm VWR 48393-048

Dissecting microscope Leica MZ6 Leica Microsystems Inc. n/a

CO2 fruit fly anesthesia pad Genesee Scienific 59-114

Tris-HCL pH7.5 Sigma-Aldrich 1185-53-1

Magnesium chloride Sigma-Aldrich 7791-18-6

NaCl Sigma-Aldrich 7647-14-5

Spinning disc confocal microscope Leica DMI-4000B inverted microscope 

equipped with Yokogawa CSU 10 spinning 

disc Leica Microsystems Inc.

n/a

Hamamatsu C9100-13 ImagEM EMCCD 

camera Hamamatsu n/a

PatchMan NP 2  Micromanipulator Eppendorf Inc. 920000037

FemtoJet Microinjector Eppendorf Inc. 920010504

Injection needle: Femtotips II Eppendorf Inc. 930000043

Loading tip: 20ul Microloader Eppendorf Inc. 930001007
Micro Cover glasses no. 1 or 1.5, 

22x40mm VWR

48393-026; 

48393-172

Dry yeast Any grocery store n/a

Computer, > 20 GB RAM
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Comments/Description

Photon counting spectrofluorometer

Thin tweezers are very important to separate out the 

individual egg chambers

Although processing can be carried out on most 

computers, higher capabilities will increase the speed 

of the processing



Author Agreement Click here to access/download;Author License Agreement
(ALA);AgreementJoVE.PDF

http://www.editorialmanager.com/jove/download.aspx?id=878729&guid=3f70c84d-f40a-4e9f-8b06-fb354e2063c9&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=878729&guid=3f70c84d-f40a-4e9f-8b06-fb354e2063c9&scheme=1






Page 1 of 22 
 

Rebuttal Document for JoVE58545 manuscript 

Editorial comments: 

Changes to be made by the Author(s): 

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are no 

spelling or grammar issues. 

We performed further proofreading of the manuscript. 

 

2. Please revise lines 98-100 to avoid previously published text. 

We revised these lines, and are now included in the DISCUSSION section: 

“To address this, we have written a Python-based program (PinMol) that readily identifies accessible 

target sites within an mRNA by considering suboptimal secondary structures in addition to the MFE, as 

well as designs hairpin probes, which are best suited for detection of mRNAs in live cells24. PinMol uses 

structural information from secondary structures of the target RNA predicted via energy minimization 

approaches and by including information from suboptimal structures, the flexibility or rigidity of specific 

targeted regions is assessed when designing MBs.” 

 

3. Figure 1: There is no panel A’ but panel C’ in Figure 1. Please describe panel C’ in the figure legend. 

The figure legend was corrected and re-arranged to match Fig. 1. 

 

4. Figure 3: Please define the arrowhead and asterisk symbol in the figure legend. 

The missing info was added in the Fig. 3 legend. 

 

5. Please rephrase the Short Abstract to clearly describe the protocol and its applications in complete 

sentences between 10-50 words: “Here, we present a protocol to …” 

The short abstract was rephrased, as requested: 

“Here, we present a protocol for the visualization, detection, analysis and tracking of endogenous mRNA 

trafficking in live Drosophila melanogaster egg chamber using molecular beacons, spinning disc confocal 

microscopy and open-source analysis software.” 

 

6. The current Long Abstract is over the 150-300 word limit. Please shorten it. 

The long abstract was shortened, and now contains 292 words. 

Rebuttal Letter Click here to access/download;Rebuttal Letter;Editorial
comments_Rebuttal_080618.docx
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7. Please include a space between all numbers and their corresponding units: 15 mL, 37 °C, 60 s; etc. 

Spaces were added before all measurement units. 

 

8. Please revise the protocol to contain only action items that direct the reader to do something. The 

actions should be described in the imperative tense in complete sentences wherever possible. Avoid 

usage of phrases such as “could be,” “should be,” and “would be” throughout the Protocol. Any text that 

cannot be written in the imperative tense may be added as a “Note.” 

The protocol was revised as suggested. 

 

9. Please discuss Fig. 1B in the manuscript. 

Fig. 1B is now referenced in the text. 

 

10. Discussion: Please also discuss critical steps within the protocol, any modifications and 

troubleshooting of the technique. 

This information was added in the Discussion section and is also described in our response to the 

reviewers’ critiques/requests. 

 

11. References: Please do not abbreviate journal titles. 

We edited the final document after references were converted to text. 

 

Reviewers' comments: 

 

Reviewer #1: 

 

Manuscript Summary: 

The authors present a potentially highly valuable method for labeling endogenous mRNAs in living 

Drosophila oocytes using molecular beacons. A method like this has the potential to complement and 

extend the current bacteriophage stem loop-mediated labeling of artificial reporter transcripts, but this 

method has not been widely adopted. The protocol presented here could provide a valuable resource. 

 

Major Concerns: 

However, in its current form, the manuscript leaves out important details that potential users would find 

very helpful if they wish to adopt the method. There are two major areas that must be addressed.  

1) First, the criteria for designing well-behaved MBs must be explicitly described. 
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We included the following information in the DISCUSSION section, and most of it is extensively covered 

in the literature of specialty: 

“An MB’s performance efficiency in live cell imaging experiments leans on the capability of the probe 

sequence to hybridize to the corresponding complementary sequence within the mRNA target, which is 

determined by the target structure. The predicted MFE RNA secondary structure obtained using in vitro 

measured thermodynamics parameters is valuable in assessing target accessibility, but ultimately it is 

the in vivo target structure and the target interaction with other cellular factors that will determine the 

MB’s suitability for live cell imaging. Genome-wide analysis of RNA secondary structure suggests that 

many RNAs are less structured in vivo than in vitro35. Although the efficiency of in vivo target detection 

using MBs is mainly dependent on the accessibility of the binding site, optimizing certain MB features 

will ensure an enhanced visualization of the mRNA target. Specifically, a careful selection of the 

following parameters should be performed: 1) the probe length can vary between 18 and 26, such that 

the probe’s nucleotide composition is between 31 and 55% GC pairs in the target:MB hybrid, 2) the 5 bp 

stem sequence should be G/C rich, to maintain the hairpin shape in absence of mRNA target and to 

provide mismatch discrimination, 3) a modified backbone should be used for protection against 

nucleases of both MB and target:MB hybrid, 4) the fluorophore/quencher pair can offer an additional 

modest stability to the MB’s stem, and 5) the fluorophore should be stable during long imaging time 

intervals. In addition, classical MBs usually generate a nuclear non-specific signal34, which in our case 

only moderately impacts data processing and analysis. However, for mRNA trafficking visualization at 

cellular level, this non-specific signal may become problematic. Several groups have proposed 

modifications or tags, such as tRNA, peptides and nanoparticles, which prevent the delivery of MBs into 

the nucleus and thus eliminate this possible non-specific signal33,36.” 

2) Second, and perhaps more importantly, the degree of nonspecific labeling appears to be 

massive, at least in nuclei, vastly outweighing the putatively specific signal, as judging from 

Figures 2 and 3. Any reader of this protocol will be rightfully skeptical about the reliability of the 

method, given the data presented. These issues should be addressed before the manuscript is 

suitable for publication.  

The nuclear non-specific signal generated by MBs is well documented in the literature. In our case our 

analysis is not impeded by it and therefore we have not employed any of the modification optimized by 

other groups that minimize this non-specific signal. In addition, MS2/MCP tagging, the main alternative 

method for visualization of RNA transport in live cells, also generates a non-specific fluorescent signal in 

the nucleus. We included this information in the DISCUSSION section: 

“In addition, classical MBs usually generate a nuclear non-specific signal34, which in our case only 

moderately impacts data processing and analysis. However, for mRNA trafficking visualization at cellular 

level, this non-specific signal may become problematic. Several groups have proposed modifications or 

tags, such as tRNA, peptides and nanoparticles, which prevent the delivery of MBs into the nucleus and 

thus eliminate this possible non-specific signal33,36.” 

Comments follow: 



Page 4 of 22 
 

3) Section 1: Design of MBs: As written, the protocol provides no information regarding the criteria 

for MB selecting sequences. Overall, much more guidance is needed. It seems particularly 

important to provide as much information as possible regarding MB design given that the 

authors state "The biggest drawback of this approach has been the design of MBs for live cell 

imaging." Could the authors describe something about their experience designing these probes 

to give a new user some hints about features of well-behaved versus poorly performing probes? 

We now include general guidelines to design MBs in the DISCUSSION section, also see our response for 

the first major area to be addressed. The specific details on how PinMol works to include our 

recommendations for designing MBs make up a whole new manuscript that is available on bioRχiv, as 

referenced in this manuscript, and which is currently pending review at the RNA Journal. 

 

4) 1.1.1 Could the authors briefly describe the use of the RNA folding website. It is not clear what 

exactly is the goal of this step. 

The goal is mentioned in the main step 1.1, specifically, to obtain the predicted secondary structures for 

the target mRNA of interest. We re-worded the description of step 1.1.1. (please see below, Reviewer 1 

comment #7). 

5) Should the user try to maximize the number of probes, or some features of their sequence?  

At this step there are no probes designed, this is only to predict the TARGET secondary structures, which 

are comprised of the minimum free energy structure (MFE) and a user-dependent number of sub-

optimal structures. 

6) What is meant by "5 or 10% sub-optimality"? 

This defines how many suboptimal structures will be considered to generate the file (ss-count file) that 

is used as input for the PinMol analysis. X% sub-optimality means that structures that have a free energy 

value that is within 5% of the MFE value will be included in the analysis. 

7) What is the effect on the number of potential MBs of choosing either 5 or 10%? Can the user 

choose other values (0? 20?)? Should values other than 5 or 10 be avoided? What is the upper 

bound of number of computed foldings? 

This depends on each mRNA and its sequence. We have not analyzed a range of sub-optimality, but we 

found that using 5 or 10% improves the MB design by identifying regions within the target mRNA that 

may be flexible or rigid. This is also described in the PinMol manuscript. 

We modified this step to include more details, and included a new Note, as follows: 

“1.1.1. Paste/upload the target sequence in FASTA format, select 5 or 10% sub-optimality (structures 

with a free energy of folding within 5 or 10% of the MFE value, respectively), and adjust the maximum 

number of computed foldings accordingly (e.g. larger for 10% sub-optimality; Note 1). “ 
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“Note 1: Inclusion of sub-optimal secondary structures when designing MBs allows for the identification 

of regions within the target mRNA that may be more flexible or more rigid than as predicted for the 

minimum free energy (MFE) structure alone, which improves the overall design of MBs suited for live 

cell imaging.” 

 

8) 1.2.2 Please state explicitly what the user should do after "comparing with any positive BLAST 

hits." 

The following sentence was added: 

“Eliminate probes that show > 50% cross-homology with other mRNAs that are also expressed in the 

tissue/cell of interest.” 

 

9) 1.3 Are there resources where a reader could find a list of fluor-quencher pairs? 

The reference relevant to MB design is now provided. 

 

10) Note 2: "A more rigorous characterization" Please say explicitly that the more rigorous assay is 

obtained by using in vitro synthesized RNA instead of DNA oligos in the thermal denaturation 

assay in section 2.3, if this is what the authors mean to indicate. Otherwise it is not clear what is 

the more rigorous assay, or what comparison is being made. 

This is now Note 3, and was modified as suggested: 

“Note 3: A more rigorous characterization of the MB’s efficiency to detect the targeted sequence can be 

performed using in vitro synthesized RNA targets instead of complementary DNA oligonucleotides8.” 

 

11) 2.1 When the authors say to purify by HPLC, one suspects they are referring to purification of 

MBs from in-house synthesis and not to those obtained by vendors. Please rearrange this section 

to clarify. For those users wishing to perform HPLC on their in-house synthesized MBs, please 

provide either more details on HPLC setup or an explicit reference (e.g. reference 7). 

Oligonucleotides prepared using either method should be purified using HPLC. A commercial provider 

will have a mandatory purification (gel or HPLC) for this type of oligonucleotides. We modified the text 

as suggested: 

“2.1. Use in-house synthesis and purification as previously described7, or services from commercial 

providers, to synthesize and purify one to five MBs (see Note 2), using the following labeling scheme: 

[5’(Fluorophore)-(C3 or C6 linker)-(2’-O-methyl MB sequence)-(Quencher)3’]. Purify MBs using reverse-

phase HPLC, in house or using the services of the commercial provider.” 
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12) 2.3 Please briefly describe the assay of thermal denaturation and what the user should be 

looking for. One imagines that MBs in vitro might exhibit different behavior from in vivo 

behavior. In cases where the denaturation assay suggests a probe is poorly behaved, is it ever 

worthwhile to check its behavior upon injection? Conversely, how often do MBs that perform 

well in vitro yield no signal or only nonspecific signal in vivo? 

This step was split into three steps, and edited as follows: 

“2.3. Perform thermal denaturation of the MB alone and measure its melting temperature (Tm) and 

confirm that the MB assumes the desired hairpin shape at physiological temperature. We observed Tm 

values between 60 and 90 °C. 

 

2.4 Perform thermal denaturation of the MB in the presence of the DNA oligonucleotide target and 

measure the MB:DNA target hybrid’s Tm, as previously described7. A Tm between 55 and 60 °C is 

desired for the MB:DNA hybrid. 

 

2.5 Perform in vitro hybridization reactions with the corresponding DNA oligonucleotide target, and 

determine the efficiency of MB:DNA hybrid formation at physiological temperature, as previously 

described7. Fast hybridization kinetics with the DNA target mimic is desired, however MBs that do not 

show high hybridization efficiency with DNA targets may have a better performance with the target 

mRNA in vitro and/or in vivo.” 

Line 198 has a reference to a section 2.4, but there is no section 2.4. 

This is now true after step 2.3 was split. 

 

13) 3.4 Describe why it is necessary to remove the youngest stages. Which stages do the authors 

consider the youngest? 

This step was edited to include the requested information: 

“3.4. Explant the ovaries onto an oil drop on a new coverslip. Gently hold one ovary with one tweezer 

while pinching off the youngest stages of the ovariole with the other tweezer. oskar mRNA is actively 

localized at and after mid-oogenesis (stages > 7), and younger egg chambers ( stages < 7) are more 

difficult to inject and do not survive as long. Slowly drag on the cover slip (with a downward movement) 

until individual ovarioles or egg chambers are isolated and aligned vertically. Further separate single egg 

chambers by displacing the unwanted stages from the ovariole egg chain (see Note 4).” 

 

14) Section 4 Perhaps include a reference to the "table of materials" so that a reader can find some 

information about the injection apparatus. 
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We included the requested reference. 

 

15) Sections 5: 

-a reference to the table of material might be helpful so the reader can see what confocal setup 

is used. 

 

We included the requested reference. 

16) -Could the authors describe in more detail some of their imaging parameters? For example, what 

is the physical size represented by the voxels in their image stacks? What is the pixel dwell time? 

Do the authors have an estimate of the laser power applied to the sample? Some guidelines will 

be helpful for a potential user to get started with the 

This comment appears to be incomplete. We are providing the requested details for Fig. 4, but these will 

be different for different microscope set-ups, and depend heavily on the sample and RNA target of 

interest, quality of the objective, type of camera used, age of the set-up, etc. The details are now 

provided in the Fig. 4 legend. Instead of the pixel dwell time, which can be varied in a single-point laser 

scanning setup, we provided exposure times for our acquisition protocol with the spinning disc confocal 

microscope. 

 

17) Section 6 processing: 

 

-The header to section 6 says "using Icy and/or ImageJ, but the protocol switches between the 2 

programs. This seems like extra work if the preparation can be done in only Icy, which is what the 

header to Section 6 implies. 

ImageJ is incorporated within Icy, basically only Icy is used, ImageJ is not separately opened. 

 

18) -Authors should recommend criteria for determining background/nonspecific fluorescence. If MB 

binding is specific, then one imagines the background will be quite low and the majority of the 

signal will be "true" signal. 

Within the cytoplasm and in in vitro hybridization experiments, the background signal mainly arises from 

how effective the quenching of the fluorophore is, and not from non-specific binding. Lower 

performance can be due to the type of fluorophore/quencher pair and an ineffective quencher, weak 

stem region, improper MB folding. Usually this is indicated with the signal:background (S:B) ratio for 

each MB, which is determined during the characterization of the MB using in vitro hybridization. 

However, as the reviewer noted, the in vivo and in vitro performance of the MB will likely differ. As an 

example we provided the S:B measured using the corresponding DNA target oligonucleotides, for 

osk1236 and osk2216 in step 6.1.6: 
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“6.1.6. Subtract background either using a background stack: ImageJ>Process>Image Calculator…, or 

using the Rolling ball option: ImageJ>Process>Subtract Background…, select the Rolling ball radius. 

Preview the image for the radius selected before selecting “Accept”. Background signal will mainly arise 

from improper quenching of the flurorophore. The signal:background ratio (S:B) is often used as an 

indicator for an MB’s “brightness”, and it is measured from in vitro hybridization experiments of the MB 

and DNA target oligonucleotide. For example, MBs osk1236 and osk2216 have an S:B of ~81 and ~120, 

respectively.” 

 

19) -Related to the preceding comment, what is the detection threshold for this method? That is, can 

MBs detect single mRNA molecules? Given the high density of osk in oocytes and nurse cells, one 

suspects that single mRNA detection is out of the question. On the other hand, the labeling might 

be very efficient, so perhaps single molecule detection is possible. Can the authors give any 

estimate of the minimum number of mRNAs per osk RNP that their MBs can detect? 

As mentioned in the manuscript for Figs. 4 and 5, the detection performance can be improved by 

preparing several MBs for one mRNA target. And, we previously reported a detailed characterization of 

oskar mRNPs trafficking, where we found that hundreds of mRNA copies can make up large oskar 

mRNPs, which are dynamically remodeled during transport. We included the following information in 

the DISCUSSION section: 

“We previously reported that oskar mRNP undergoes extensive remodeling during transport from the 

nurse cells into the oocyte23. In addition, using MBs we characterized the temporal and spatial 

characteristics of endogenous oskar mRNA trafficking, and found that hundreds of oskar transcript 

copies can be incorporated to form large oskar mRNPs.” 

Line 474 there is a reference to a Fig. 6, but the authors mean Fig. 5. 

The text was corrected. 

 

20) Figures and legends: 

 

Fig 1: The legend does not correspond to the figure. A and A' refer to panels labeled C and C', B 

refers to panel labeled A, and C refers to B. It appears osk2216 is not listed in panel B. It would be 

preferable if the MB shown in panel C' was the same as the one depicted in its binding 

conformation in C. 

We rectified this oversight. 

 

21) Fig 2: How many nurse cells were injected? Can the authors please comment on the appearance 

in Fig 2A, top row, of fluorescence in what appears to be an uninjected nurse cell? I assume this 
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is due to MB entering this NC from the oocyte and not from "retrograde" osk mRNA transport, 

but this should be stated explicitly. 

We perform microinjection in only one site, which can be the nurse cell cytoplasm or the ooplasm. 

When injected in the nurse cells the MBs freely diffuse into other nurse cells, which are inter-connected 

and connected with the oocyte through ring canals (see Fig. 1A), and different nurse cells can have can 

have different “uptake efficiency” of the MB depending on its relative position to the injection site. In 

Fig. 2A, for t = 0 min panel only the injected nurse cell presents fluorescence signal, and MB from the 

injected nurse cells is also present in the other nurse cell in later time points. We included this detail in 

REPRESENTATIVE RESULTS section: 

“We previously reported that oskar mRNP undergoes extensive remodeling during transport from the 

nurse cells into the oocyte23. In addition, using MBs we characterized the temporal and spatial 

characteristics of endogenous oskar mRNA trafficking, and found that hundreds of oskar transcript 

copies can be incorporated to form large oskar mRNPs.” 

22) The degree of signal from the nurse cell nuclei and the germinal vesicle is massive and very 

striking. The authors say this arises from "classical MBs" that "give rise to nonspecific signal 

within nuclei." This massive nonspecific labeling seems to be the main limitation of this method. 

Why is the signal so strong in nuclei? The authors briefly mention ways to reduce non-specific 

signal. Given the huge nonspecific signal, shouldn't such modifications be used by default? Why 

should the reader believe that objects detected in the cytoplasm are in fact the mRNAs of 

interest? Can the authors please provide evidence, reasoning, or references regarding the degree 

of nonspecific labeling within the cytoplasm? Without some explicit discussion of the nuclear 

(and potentially other) non-specific signal, a potential user of this protocol will look upon the 

method with no small degree of skepticism about its usefulness. 

The specificity of MBs is well established [Bratu, D. P. et al. Proc Natl Acad Sci U S A. 100 (23), 13308-

13313, (2003); Mhlanga, M. M. et al. PLoS One. 4 (7), e6241, (2009)]. We have confirmed the specificity 

of MBs in detection of the mRNA of interest by co-injecting oskar-specific MBs with in vitro transcribed 

oskar RNA labeled with a fluorophore spectrally distinct from the one used to label the MB. More 

importantly, we confirmed the MBs specificity in detecting endogenous oskar mRNA using a FRET 

approach with two  MBs binding to adjacent sites on the mRNA target. The non-specific nuclear signal is 

sequestered in the nucleus is not believed to be exported within the nurse cell cytoplasm. We included 

this information in the REPRESENTATIVE RESULTS section: 

 “In spite of this nuclear non-specific signal, the specificity of MBs for in vivo detection of oskar mRNA 

has been established using a FRET approach8, and MB co-injection with in vitro transcribed oskar mRNA 

labeled with a fluorophore spectrally distinct from the MB’s label23.” 

23) In the legend to Figure 3, please describe what features are being highlighted by the asterisk and 

arrowhead. 
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Please see Editorial comment #4. 

 

24) In Figure 4, what is the physical distance represented by 4 pixels? Is this 4 pixels in XY alone or in 

Z as well? In the legend there is not much information conveyed by e.g. "scale 2, sensitivity 50." 

This doesn't help the reader understand the quantities of interest, such as the probability of 

successfully detecting an osk RNP, or the fraction of signals that are false positives. 

The object-based colocalization protocol performs object detection in each Z, therefore the 4 pixel 

distance refers to the XY plane, and the pixel size is now provided (see also Reviewer 1 comment #16). 

The scale and sensitivity are determined by trial and error and depend on the data analyzed. Object-

based colocalization allows one to visually inspect the data and find any false positives. In our analyses 

we found that low-intensity objects will not be detected, rather than the background signal to be 

identified as an object. Icy offers additional colocalization methods, but we chose the object-based 

colocalization to show the detected objects. 

 

25) The authors state that 57% and 93% of MB particles are colocalized with an MS2 particle. This 

implies that this mean that 43% and 7% of MB particles are not MS2-containing particles. The 

reader will also be interested in the converse, the fraction of MS2 particles that are labeled by 

MBs. From the images presented, it appears that the majority of MS2 particles are not labeled by 

MBs. Please provide some measurement of the degree of labeling of MS2-containing particles. 

Please also provide the number of objects assayed to arrive at these percentages. This will help 

give the reader a sense of the detection efficiency. 

The relevant text within the REPRESENTATIVE RESULTS was edited to include this information: 

“At 12 and 14 min post-injection, 57% (7 MB-objects and 13 GFP-objects, with 4 colocalized objects) and 

93% (30 MB-objects and 51 GFP-objects, with 28 colocalized objects) of detected MB particles 

colocalized with GFP particles in the nurse cells and oocyte, respectively. Our analysis yields 31% and 

55% colocalization percentages of oskar-MS2 mRNA with oskar mRNA detected with MBs within the 

cytoplasm of a nurse cell and the oocyte, respectively.” 

 

26) Moreover, some explanation is needed for the percentages that are presented. At first glance, if 

the MS2-labeled transcript is expressed from a transgene in a genetic background with normal 

levels of endogenous osk expression, then there will be at least as many (and likely more) non-

MS2-containing osk transcripts as MS2-containing ones. So one naively expects a large fraction, 

and likely the majority, of MB particles not to colocalize with MS2, whereas the authors report 

the opposite. (Please provide the genotype and a reference for the osk-MS2 and MCP-GFP 

transgenic lines). 

Premature and overexpression and/or ectopic expression of Oskar protein is toxic to egg chamber 

development and is embryonic lethal, therefore the oskar-MS2 transgene was generated in an oskar-
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null background. The oskar-MS2/MCP-GFP construct consisted of 10 MS2-binding sites inserted into an 

Spe1 site that was introduced immediately after the oskar stop codon in a oskA87/Df(3R)pXT103 

background [Zimyanin, V.L., et al. Cell 134 (5), 843-853, (2009)]. The reviewer’s statement and inquiries 

assume that all transgenic oskar mRNA transcripts are labeled with MCP-GFP. The oskar-MS2 system 

only claims that the GFP cytoplasmic signal (and not the non-specific nuclear GFP signal) is 

representative of endogenous oskar mRNA trafficking. To our knowledge it has not be shown that the 

oskar-MS2 transgene only expresses the full length oskar-MS2 mRNA, or that there is no truncation of 

the MCP and all the MCP is GFP tagged, or even that there are is no free GFP signal.  Based on the 

specificity of oskar MBs, we propose that it is more likely that our nuclease-stable probes are reporting 

on transgenic oskar copies that are not labeled rather than giving non-specific signal. But it is beyond of 

the scope of this manuscript to analyze the MS2 system, which has been recently questioned and 

reported to yield non-specific effects. In yeast, it was shown that the genetic introduction of MS2 loops 

seems to produce decay intermediates that could possibly disrupt RNA metabolism and localization 

dynamics [Garcia and Parker RNA,. 21 (8), 1393-1395, (2015)]. 

We provided the requested percentage in REPRESENTATIVE RESULTS section, please also see Reviewer 1 

comment #25. 

 

27) However, osk is packaged into RNPs containing many osk mRNAs. In all likelihood these RNPs do 

not discriminate between MS2-containing and -noncontaining mRNAs. Such co-packaging would 

explain why only 7% of MB particles do not contain MS2: the detectable MB particles are only 

those containing many copies of oskar. The authors should comment on this observation since it 

bears heavily on the question of detection efficiency. 

Please see our above response for Reviewer 1 comment #26. There is no endogenous oskar mRNA 

expression in the oskar-MS2 transgenic ovaries, thus this explanation is unlikely. In addition, the GFP tag 

is known to mediate aggregation, which gives another reason why this transgene can induce artifacts. 

28) Discussion: Line 544 refers to "the kind and size [of] mRNA particle." osk RNPs are smaller than 

the diffraction limit. It is odd to discuss the size of particles whose physical size cannot be 

assayed with the methods presented. Please describe what size refers to in this context. 

In our lab we also employ superresolution microscopy of fixed samples, which we initially considered to 

include as supporting material for colocalization studies, however we decided it was beyond the scope 

of this manuscript. We modified the highlighted text and removed the mention of “size”. 

 

29) In the table of materials, there is a listing of "Computer capabilities > 20 RAM" Presumably the 

units on 20 are GB, please modify for clarity. 

The information was corrected to show the unit. 
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Reviewer #2: 

 

Manuscript Summary: 

This manuscript describes protocols for designing and delivering molecular beacons (MBs) into 

Drosophila egg chambers and the subsequent imaging of hybridized MBs in vivo. Molecular beacons are 

the only available methodology for visualizing and tracking the dynamic behavior of endogenous mRNA 

transcripts in real time. However, the difficulties associated with designing molecular beacon probes 

have prevented more cell biologist from using this tool. In response, the Bratu lab has developed a new 

software application, PinMol, that uses the target mRNA sequence and secondary structure to efficiently 

design sensitive and specific molecular beacons. 

 

Major Concerns: 

 

Introduction: 

The Introduction is most/more appropriate for a primary research article written for experts familiar with 

molecular beacons. However, it should be written for researchers who are not familiar with MBs, but are 

interested in potentially using them. I kept this in mind when reading/reviewing the manuscript. What 

would a researcher new to beacons want to know. 

The focus of this manuscript is using MBs to visualize transport of endogenous mRNA. The editor 

mentioned from the beginning to stay away from computational/software description and present 

experimental results showing detection and tracking of endogenous mRNA. Please also see our response 

to Reviewer 1 comment #3. 

 

1) The protocol would appeal to a broader audience if the introduction focused more on the structural 

and functional design of MBs and their general applications and less on Drosophila egg chambers.  

This is not possible, as the manuscript with the detailed description of MB design using PinMol is freely 

available on biorχiv, and is currently under review at the RNA Journal. In addition, the JoVE team asked 

us to focus on our experimental expertise rather than the computational design of MBs. 

2) Some suggestions for broadening the appeal of the protocol introduction and making it a more useful 

resource: 

1. Change the title to: Visualizing and Tracking Endogenous RNAs Using Molecular Beacons 

We believe it is important for the readers to know that our protocol was developed using fruit fly egg 

chambers, and we would like to keep the title as is. 

 

2. Discuss the following information in the Introduction: 
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a. MBs have been used to detect mRNA. Have they been or could they be used to detect non-coding 

RNA? 

We included the requested information in the INTRODUCTION section: 

“Several groups have had success in using MBs to detect both non-coding RNAs (microRNAs and 

lncRNAs)10-13, RNA retroviruses14 and dynamic DNA-protein interactions15. They have been successfully 

employed for imaging in various organisms and tissues, such as zebrafish embryos16, neurons13, tumor 

tissue17, differentiating cardiomyocytes18, and Salmonella19.” 

 

b. What are some examples of tissue/cell types analyzed with molecular beacons? 

We included the requested information in the INTRODUCTION section, see our response for the above 

comment (2a). 

 

c. What factors should be considered when someone wants to begin using molecular beacons? 

i. How do copy number & alternative splicing affect the usefulness of molecular beacons? 

We already discussed in the manuscript how to improve visualization of low abundance targets, and this 

information is included in the DISCUSSION section, as we were guided by the editor. 

“This is essential for the detection of low copy number transcripts where the fluorescent signal must be 

increased above background. By scaling up the MB numbers which effectively hybridize to several 

accessible sites on a target mRNA, the signal amplification can be achieved. Therefore, this program 

facilitates a fast approach to design multiple MBs per target mRNA, and to simultaneously visualize 

numerous mRNAs in a live cell. ” 

 

ii. What are the limitations of molecular beacons? Are some RNAs poor targets for MBs? If yes, why? 

“Several MBs can be easily designed for target mRNAs of average length. However, some limitations 

may be encountered for short and/or highly structured targets. This can be overcome by adopting our 

tiny molecular beacons, for which the probe region is approximately half of the length of a classical MB 

probe31.” 

 

iii. In general, what type of microscope set-up is needed to visualize MBs. How fast must they be? Can a 

standard confocal be used or is a spinning disc confocal required? 

This depends on the events needed to be captured, we now provide acquisition parameters for the 

dataset presented in Fig. 4, please also see our response for Reviewer 1 comment #16.  

 

d. A brief summary/overview of the procedure would be helpful to the researcher who has not worked 



Page 14 of 22 
 

with beacons. In other words, what are the key procedures involved in using molecular beacons. 1. 

Design MB, 2. MB synthesis, purification & characterization, 3. Introduce MB into cell, 4. Image 

intracellular MB, 5. MB spot detection and tracking. 

We believe that the numbered protocol steps already provide this information. 

 

3) Line 133: The authors write "Upon image acquisition, it is essential that subsequent analysis steps are 

also completed carefully and precisely." This statement is too nonspecific and uninformative. It would be 

more useful to know why the image is processed and how it is analyzed. In other words, what purposes 

do these processes/software serve? 

This is detailed within the PROTOCOL section, and this text has been moved from the INTRODUCTION to 

the DISCUSSION to address Editorial comment #10. 

 

4) What controls are done? If you see a signal, how do you know that you are detecting the desired 

target transcript? 

The specificity of oskar molecular beacons is well documented, and the manuscript has been edited to 

include details and the relevant references. Please also see our response for Reviewer 1 comment #22. 

 

5) Line 478-484: Figure 1 legend does not match Figure 1. e.g. - (A) in Figure 1 shows a mid-stage egg 

chamber, however (A) in the figure legend states "Secondary structure region within oskar mRNA 

targeted by a molecular beacon." 

Please see Editorial comment #3. 

 

Minor Concerns: 

 

Introduction: 

6) Lines 46-47: The aptamer discussion in the long abstract is ambiguous and confusing and distracts 

from the discussion of molecular beacons. The statement "extensive genetic manipulation of the tissue") 

is too vague. This statement needs to be more precise (similar to line 77). I recommend first discussing 

the efficacy of molecular beacons and following this up with a comparison of MBs and aptamers. 

This text has been deleted from the LONG ABSTRACT, please see our response to Editorial comment #6.  

 

7) Line 84/85: The authors write "A technology that addresses this concern and offers additional unique 

advantages is the nucleic acid-based approach. Nucleic acid-based tool would be more accurate. 

The text was revised as recommended. 

 

8) Line 95: The authors write "The biggest drawback of the approach has been the design of MBs for live 
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cell imaging." "Has been the design of MBs" is ambiguous. Are the authors deferring to the act of 

manually designing the beacons or their structural design. I believe they are referring to the former, 

however this is open to interpretation. 

The manuscript was edited for clarification. This text is now part of the DISCUSSION section. 

 

9) Line 101: The authors write "Additionally, highly regulated stretches of RNA (e.g. binding sites for 

microRNAs or RNA binding proteins) should not be considered as target sites when selecting probes, as 

these regions may result in inefficient binding of the MBs." Does PinMol eliminate these or is this 

something the researcher needs to do? As state, it is nor clear. 

To clarify we added the following sentence: 

“The user can evaluate and eliminate probes targeting these sites, or restrict the target region used by 

PinMol to design probes, so it does not include such sites.” 

 

Protocol: 

 

1. Design of MBs for live cell imaging. 

 

Line 156-157: "adjust the upper bound of number of computed foldings accordingly" does not make 

sense 

We replaced “upper bound of the number” with “maximum number”. 

 

Line 167: Why does the researcher need to determine the specificity of selected MBs? What is this 

information used for? Are you looking for off target hybridization? This is important information for 

someone new to this method, which is presumably why they would be using this protocol. 

First, there seems that the line numbering in the reviewers’ copy differs from the copy we received. Line 

171 mentions the specificity of the probes. This refers to possible cross-homology with other mRNA 

expressed in the tissue of interest. We added details to clarify that this sample and target-dependent 

step should be performed to ensure that other mRNAs do contain site that show high-complementarity 

with the selected probe sequence.  Please also see our response to Reviewer 1 comment #8. 

 

2. MB synthesis, purification and characterization 

 

Lines 171-173: Why does the researcher need to determine the tissue specific expression of the target 

RNA? What is this information used for? 

Please see our response to Reviewer 1 comment #8. 
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Line 175: How does someone select the appropriate fluorophore/quencher pair? Can you recommend a 

website/reference? 

The fluorophore/quencher pair is dependent on the set-up available (e.g. wavelength of lasers for 

optimally exciting the fluorophore, emission filters). We added the relevant reference. 

 

Lines 192-200: The authors recommend synthesizing one to five MBs. What do they recommend for 

someone new to MBs? Does the number depend on the size of the target RNA? 

More MBs will enhance detection of low abundance transcripts, and this is addressed in the DISCUSSION 

section. 

 

Lines 196-200: This section is verbose and confusing. Simplify and clarify 

Since the line numbers do not correspond with our version, we assume this comment refers to lines 

200-204. We modified this as follows: 

“2.2. Synthesize DNA oligonucleotides that match the sequence of the targeted RNA region and, thus 

are complementary to the probe region of MBs, for use in in vitro characterization (see steps 2.3 to 2.5, 

Note 3). Maximize hybridization of the MB with the DNA-oligonucleotide target mimic, by including on 

each end of the DNA target four additional nucleotides, as found in the target mRNA sequence.” 

 

Lines 202-204: Why does the researcher perform thermal denaturation? 

Lines 206-208, please see our response for Reviewer 1 comment #12. 

 

3. Dissection and preparation of individual egg chambers 

 

Line 211: Should emphasize that flies should be relatively young. Young flies produce more egg 

chambers. 

We mentioned in the original manuscript to use 2-3 day old flies, which means that we collect the newly 

hatched flies and age them (while being well fed) for 2-3 days, thus providing an optimal number of mid-

oogenesis egg chambers. 

 

4. Microinjection of MBs into nurse cells of egg chambers 

 

Lines 228-232: Confusing because sentence is too long and contains too much information. Split info into 

2 sentences 

The sentence was edited as follows: 

“4.1. Prepare the MB solution, using one molecular beacon (e.g. osk2216Cy5), or a mix of two MBs that 

target different mRNAs and which are labeled with spectrally distinct fluorophores (e.g. osk2216Cy5 and 
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drongo1111Cy3). Use a concentration of 200-300 ng/µL each MB in HybBuffer (50 mM Tris-HCl - pH 7.5, 

1.5 mM MgCl2 and 100 mM NaCl). For a cocktail of four MBs labeled with the same fluorophore that are 

targeting the same mRNA at 200 ng/µL each in HybBuffer (e.g. osk82, osk1236, osk2216). Spin down the 

MB solution immediately prior to loading the needle for microinjection.” 

 

Line 243: Specify type of needle 

Included in Table of Materials? 

Yes, the information is included in the Table of Material, and we added a reference in the text. 

 

Discussion: 

 

Lines 537-542: The authors discuss post-acquisition processing of images. This section describes the 

potential uses of molecular beacons and would be useful in the introduction. 

We included examples and references for usage of MBs to detect RNA targets in other organisms and 

tissues in the INTRODUCTION section, please see our response to Reviewer 2 comment #2.  

 

 

 

 

 

Reviewer #3: 

 

Manuscript Summary: 

In their manuscript entitled "Visualizing and tracking Endogenous mRNAs in live Drosophila 

melanogaster egg chambers" Bratu at al describe a protocol that allows detection and tracking of 

mRNAs in live Drosophila tissue. This is an important protocol that could to be easily adopted to image 

non-genetically modified transcripts in living fly tissue. While all major points of the protocol seem to be 

covered the authors should better describe for each section the overall aim of the section as these are 

not clearly described. They should also better discuss the expected outcomes, potential problems and 

how to troubleshoot them. Where possible the authors should also discuss appropriate controls (see 

below in red and individual points discussed). Currently the manuscripts is written in such a way that it is 

not clear whether the protocol is set up to detect and track transport of oskar mRNA specifically using 

given MBs or that it could be adapted to track other transcripts. For these reasons the authors should 

spend more time defining the purpose and expected outcomes of each section and where possible 

provide and discuss additional controls. These are as follows: 

Some questions to consider when reviewing the manuscript (provided by JoVe) (a detailed explanation 

for each point is provided below): 

* Are the title and abstract appropriate for this methods article? YES 

* Are there any other potential applications for the method/protocol the authors could discuss? The 
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authors could also state that this same protocol could also be used to detect mRNAs in fixed tissue. If so, 

please provide a quick description. 

* Are all the materials and equipment needed listed in the table? (Please note that any basic lab 

materials or equipment do not need to be listed, e.g. pipettes.) NO (see point 6) 

* Do you think the steps listed in the procedure would lead to the described outcome? MOST LIKELY 

* Are the steps listed in the procedure clearly explained? NO. (see point 1,2). 

* Are any important steps missing from the procedure? YES (see point 3) 

* Are appropriate controls suggested? NO (see point 4, 5) 

* Are all the critical steps highlighted? NO ( see point 3) 

* Is there any additional information that would be useful to include? YES (see point 3,4,5) 

* Are the anticipated results reasonable, and if so, are they useful to readers? YES 

* Are any important references missing and are the included references useful? NO 

 

Major Concerns: 

Point 1 (see also point 2): For each section, the overall aim of the section is not clearly described, the 

expected outcomes are not discussed, potential problems and how to troubleshoot them are not 

discussed and in some cases the appropriate controls are not described. 

This comment is broad, and we hope that by addressing the comments from the previous two reviewers 

we also touched on the points that the 3rd Reviewer wants us to address. We included discussion of 

critical steps and troubleshooting in the DISCUSSION section, please also see our response to the 

Editorial comment #10. 

 

Point 2: Certain steps seem not to have relevance to the overall protocol or the relevance is not clearly 

stated. It should be clearly stated in each section what are the expected outcomes with appropriate 

controls. For example, the relevance of step 1.2.2 is not clear. How does filtering by for example tissue 

specificity contribute towards MB specificity/selectivity? 

Please see Reviewer 1 comment #8. 

 In Step 4.3., why is it important to orient the sample in the A-P axis?  

This is done to allow easy injection of nurse cells proximal to the oocyte, this info was included in the 

step description. 

In step 5.2, why is imaging in this order necessary (better) as opposed to imaging each Z stack in its 

entirety before changing channels?  

This is done for colocalization analysis purposes. If the Z-stack is first imaged in one channel and then in 

the second one, it will be difficult to assess colocalization between the two channels, as the positions of 

particles in the second channel have changed significantly by the time the first Z-stack acquisition is 

completed. We edited the end of this step to include “…, to allow for proper co-localization analysis.”. 
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Why are steps 6.2.2. - 6.2.4. and 6.2.13-6.2.16. relevant to the protocol? 

It is not clear what the reviewer is suggesting, removing the steps or adding more details? We included 

these steps to provide the user with the tools to produce image files appropriately labeled, and we 

believe they contain the necessary details. 

 In general, steps in section "Spot Detection and Tracking" are poorly explained as to why they are 

important and what choosing each of the specified commands does to the spot detection.  

The outcome of the sub-steps is described in the title of the main step title, such as “Spot detection and 

Tracking”. 

What is the expected outcome, how should images be thresholded,…what happens after each of these 

steps is completed? What does spot sensitivity mean (6.2.5.), what do "NoFiltering" or "Range of 

accepted objects" options perform (6.2.6.5.), what is "Pre Processing" in 6.2.6.2, what is "Relevant track 

processors" in 6.2.9,  

We added some details in the protocol, which we hope address this comment. 

what is sub-optimality and why would one choose 5-10% sub-optimality (step 1.1.1.)  

Please see our response to Reviewer 1 comments #4-6. 

What is a "Substack" and why is it needed (step 6.1.3).  

A substack is a selection of a range of Z steps and time points to be further analyzed, the info was 

included in step 6.1.3.. 

What is the purpose of the co-localization analysis steps? Perhaps as a control that the correct signal was 

thresholded but in this sense one does not need to track the spots in live tissue. 

Of course, colocalization analysis is not required nor possible when only one /fluorophore/color is 

visualized. 

 

Point 3: Better describe what MBs are. How long should the stem be, how long the hairpin, what should 

be the GC content, what kind of fluorophore pairs are most suitable to make an MB. This last point is not 

even discussed though the authors mention several times that one can perform multicolor imaging with 

MB.  

This is beyond the purpose of this manuscript. Please see our response to Reviewer 1 comment #1 and 

Reviewer 2 comment #1. It would be really helpful if the guidelines provided to us when we were invited 

to contribute our work would be also provided to the reviewers. 

Create a table outlining the best/most optimal fluorophore/quencher pairs. Currently, only two such 

examples are given (cy3/BHQ2 or cy5/BHQ2). Provide more examples of good quenchers with their 

quenching properties so readers can have a choice while designing MBs.  
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Appropriate references have been provided.  

Equally importan, most of us will not attempt an in house MB synthesis/labeling. Provide suitable 

commercial providers that could synthesize MBs for us. 

This is not allowed according to the instructions provided by the JoVE team. 

 

Point 4: What is the purpose of the "in vitro" characterization of MB binding (page 5, point 2.1.-3)? This 

control seems superfluous since the in vivo controls are more relevant. If the authors deem this control 

important, they also need to describe it better (not clear as currently written).  

Please see our response to previous comments: Reviewer 1 comments #1, 12, and 18. 

Additionally, on page 11, line 453, the authors state that older MBs can give rise to non-specific signal 

but that the MBs designed with a new approach do not. Please explain why, specifically since the MBs 

were always considered as the probes that have no fluorescence unless bound to a target RNA. 

 This is already known and we have discussed it as related to the presented protocol in our response to 

Reviewer 1 comments #1 and 2. 

 

Point 5: Appropriate controls are not discussed. For example, how many MBs would one need to reliably 

detect a single mRNA either in fixed or in live tissue? How is threshold for detection of MB-labeled 

mRNAs set (it seems to vary depending on tissue, which needs to be explained why). Additionally, how do 

you control for accurate tracking of moving spots - the authors must discuss how to set up the 

parameters for correct imaging speed to allow recording of moving mRNAs and their trajectories 

(imaging too slow and only slow moving transcripts will be detected, while imaging in 3D might capture 

rapid events in 3D but will increase the bleach rate). All these aspects which will critically influence the 

outcome of the experiments have not been discussed. 

We previously characterized oskar mRNA trafficking in the egg chamber [Mhlanga, M. M. et al. PLoS 
One. 4 (7), e6241, (2009)]. The acquisition parameters, including the sampling rate, are highly 
dependent on the organism and tissue used, on the temporal and spatial gene expression and target 
mRNA trafficking, as well as on the microscope set-up. Our protocol is mainly focused on the analysis, 
but as an example, at the request of Reviewer 1, we added the acquisition parameters used for the data 
presented in Fig. 4 (see response for Reviewer 1 comment #16). 
 

Point 6: Please discuss in better detail the microscope/detector/ resolution that will allow appropriate 

imaging and tracking of mRNAs in live tissue. Also briefly describe the injection rig setup (model, 

provider,…). 

Please see our response for Reviewer 1 comment #16 and 19, and point 5 above. 

 

Point 7: Better explain why the co-localization measurements are needed to achieve tracking of moving 
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mRNAs. Are there other co-localization methods available that would be appropriate substitutes or is the 

one provided by the authors the only acceptable one (and why). Additionally, the authors detect a 4 pixel 

(define size of a pixel) distance between co-localizing spots labeled with spectrally distinct colors (page 

12, line 501). Is this a pixel shift? 

Colocalization is not needed for the purpose of tracking, the mRNA alone can be tracked. In this protocol 

we described object-based colocalization to illustrate how one can determine the degree of 

colocalization between an mRNA and a protein of interest. We chose oskar-MS2 to show the overlap 

between the two detection methods, but each MB and GFP can be tracked separately without 

performing colocalization analysis. Other colocalization methods have been used for mRNA localization 

in fixed D. melanogaster embryo. However, for tracking purposes we need to use object-based 

colocalization. This information/reference is now included in the DISCUSSION section.: 

“Here, we describe object-based colocalization, but colocalization, albeit without tracking, can also be 

quantified by determining the overlap and degree of colocalization using PCC(Costes) analysis using Icy  

and ImageJ plugins (Colocalization studio, JACoP)38,39” 

The size of pixel is now included for the objective used for acquisition (legend of Fig. 4). 

Minor Concerns: 

Minor points: 

- Number 1.1. in line 162 should be 1.1.2. 

In our version the step mentioned appears to be in order 1>1.1.>1.1.1.>1.1.2.l appear in order. 

 

- In point 3.1., define the age range of females. 

We clarified this information in the text. 

 

- Point 4 (line 226). It seems important to inject MBs into nurse cells and not in nurse cell nuclei or 

oocytes. Why? 

Not true, you can inject in the oocyte and Fig. 3 shows side-by-side data obtained from microinjections 

performed in the nurse cell (Fig. 3A) and oocyte (Fig. 3B). However,injecting the MB into the nurse cell 

enables us to track mRNA particles in both the nurse cell cytoplasm and ooplasm, as well as visualize 

mRNA localization in the oocyte. 

 

- Why do the authors prefer an angle smaller than 45 degrees during the injection (line 244). 

To make sure you don’t puncture several nurse cells, and the info was included in the text. 

 

- A step is missing (or is it) after 4.11. where the needle is removed from sample? 
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We included an additional step: 

“4.12. Gently remove the needle and retract it to the home position.” 

 

- Define "XYZCt" 

This info was included in step 5.1. 

 

- …30 min time points should perhaps be "min after MB injection"? (line 487) 

We added “…, after initiation of acquisition”. in the legend of Fig. 2. 

 

- Are the measurements performed every 30 sec for 20 min in Z (line 497)? 

This information is included in the legend of Fig. 4: 

“XY-projections of 14 Z optical slices at 0.3 µm steps.”. 
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